& IT Essentials - Level 1

While holding the mouse with the right
hand the index finger is placed on the left
button and the middle finger on the right
button. While holding the mouse with the
left hand, the index finger is placed on
the right button and the middle finger is
placed on the left button of the mouse.

The rest of the fingers are placed on the
sides to help us move the mouse.

If we are using a touchpad, we can use our
index finger to move the mouse pointer.

=% Demonstrate the correct way to hold the mouse. Emphasize the importance
of gently pressing the mouse buttons.

@ Key points e )

«  The keys with the letters A-Z are called alphabet keys.

« The keys with the numbers 0-9 are called number keys.

« A mouse has two buttons: the left button and the right button.
Left-click, right-click and double-click are the three types of mouse clicks.
The mouse is kept on a flat surface called the mouse pad.

The mouse pad helps the mouse cursor move smoothly across the computer
screen.

Nazl, Education
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Worksheet )

1. On the keyboard below, colour the Enter key red, the alphabet keys
green and the number keys yellow.
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2. In the picture of the mouse shown here, colour the left button red and mark
it as 'L’, right button green and mark it as ‘R’, scroll button blue and the
remaining part of the mouse yellow.

3. Circle the words related to a computer mouse.

right-click left-click mouse pad scroll button
rat tail double-click arow photo-click

touchpad Enter key
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Hey Aditi, what are
these devices connected These help me tell the
to your computar? computer what | want it to do,

Yesl Like we use our eyes and ears
to understand and mouth and
hands to convey information.

Ahl 5o these devices help us
send messages IN and OUT of \
the computer!

Input devices — Keyboard, mouse, scanner, microphone, and web camera
Output devices — Monitor, printer, speaker, and projector
IPO Cycle

A computer is an electronic machine. It has different parts like monitor,
keyboard, mouse, CPU cabinet, etc.

Based on their function, the parts of a computer are divided into two types:
input devices and output devices.

Input devices

The parts that allow us to give input to the computer are called input devices.
A few examples of input devices are keyboard, mouse, scanner, microphone,
web camera, etc.

Keyboard:

(a) It has many buttons called keys on it.

(b) It is used to type on the computer.

Mouse:
(a) A mouse is used to draw pictures.

(b) It is used to point and select things on
the monitor.
Microphone:

(a) A micrephone is used to record our voice
into the computer.

Scanner;

(a) When we place a paper with text or
pictures inside a scanner, it takes an exact
copy of it and stores it in the computer.

Web Camera:

(a) A web camera is used to capture a picture
or record a video.

| Of 2
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o The leading computer peripherals manufacturing company HP was started
in a garage at Palo Alto in the year 1939,

Output devices

The output devices show us the final result of the work done. For example:
monitor, printer, speaker and projector.

Monitor:

(a) Tt looks like a T.V. screen. All the
work we do on the computer is
displayed on the monitor.

Printer:

(a) A printer prints out the text or
images on a paper.

Speaker:

(a) We can hear sounds or music
on the computer through the
speakers.

Projector:

(a) A projector shows videos, images
or computer data on a bigger
screen so that many people can
see it together.

. Take the students to the computer lab and show them the input
and output devices.

P

]

As you know, the computer is a machine similar to an iron, washing machine,
refrigerator etc.

L
~

==

Iron Washing machine Refrigerator
Machines cannot work on their own. Humans have to give instructions or
commands to these to make them work.

Most of the machines work on an IPO (input-process-output) model.
Let us understand this model with a few real-life examples.
Input-process-output model of a computer

Input - Process - Output

All the work we do using computers is carried out in three simple steps:
Input-Process-Output where,

Input is the information which we provide to the computer to work on,
Process is the work done by the CPU (Central Processing Unit) on the

information given by us and
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J

As you know, the computer is a machine similar to an iron, washing machine,
refrigerator etc.

Iron Washing machine Refrigerator

Machines cannot work on their own. Humans have to give instructions or
commands to these to make them work.

Most of the machines work on an IPO (input-process-output)} model.
Let us understand this model with a few real-life examples.

Input-process-output model of a computer
Input - Process - Output

All the work we do using computers is carried out in three simple steps:
Input-Process-Output where,

Input is the information which we provide to the computer to work on,
Process is the work done by the CPU (Central Processing Unit) on the
information given by us and

| 1-EM.EE Lavesa e tinde 4

Qutput is the final result we get after processing.
Input Process
b

(5,6,+) (5+6) {1y

Data and instructions Operation

For example-

Double-click the Tux Paint icon to open the application. The CPU

understands this instruction given through the mouse and processes it. It then
displays the Tux Paint application on the monitor.
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Prcocessing by CPU
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Input: Double-clicking the Tux Output: Displag of_the Tux Paint
Paint icon application

(¥ Scanned with OKEN Scanner



& IT Essentials - Level 2

Qutput is the final result we get after processing.

Input Process
b

(5,6,.4) {5+6) (1)
Data and instructions Operation

For example-

Double-click the Tux Paint icon to open the application. The CPU
understands this instruction given through the mouse and processes it. It then
displays the Tux Paint application on the monitor.
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Input: Double-clicking the Tux Output: Dispra)! nf_the Tux Paint
Paint icon application

Information Technology

| ov-citcE Leveia_onape T3Usze 144100

W Key peints ]

A computer is an electronic device.

- Parts of a computer that help us give input to the computer are called input
devices.
Keyboard, mouse, scanner, microphone, and web camera are a few examples
of input devices.
Parts of a computer that gives the output are called output devices.
Monitors, printers, speakers, and projecters are a few examples of output
devices.

The act of changing the input to output is called processing.
The processing of instructions takes place in the CPU.

The input when processed in a certain way changes to output.

Colour the parts of the drawing as per the codes given below.
(i) Mouse - (i) Monitor - (iii) Printer -
(iv) Keyboard (v) Speakers D

=~

O
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Fill in the missing letters to complete the words.

Fill in the blanks.
(a) The act of changing the input to output is called
(b} Computer receives data withthehelpof _ devices.

() When Chetan presses keys on the keyboard, the _ detects this
and displays text on the monitor.

. Choose the correct answer.
(a) CPU stands for
(a) Control Processing Unit {b) Central Processing Unit
{c) Central Production Unit {d) Central Processing Undo

(b} Meenal presses keys on the keyboard to type her name. She sees the letters
on the

(a) monitor (b} printer

(c) mouse (d) notebook

Information Technology

() TheCPU canbe comparedtothe _ of human beings.
i) eyes nose

(i) brain hands

(d) Cooked rice can be comparedas

i) Input i) Processing
(ili) Output None of these

{e) Which of the following is a machine?

) Juicer i) Pen

(iii} Pencil Eraser
Choose the correct option.
(a) The computer is a machine. (True/False)
(b) The CPU processes instructions provided by human beings. (True/False)
(¢} The computer can act on its own. (True/False)
{d) IPO stands for Input Processing Order. (True/False)

{e) The actof changing the input to output is called processing.  [True/False)

Let’s colour and learn!

(a) Choose any drawing in your favourite colouring book and colour it.
Answer the following questions using the clues given in brackets.
[Colouring, Colour pencils, Colourful drawing]

()  What helped you colour the drawing?
- Inputs

(i) Which act changed a plain sketch to a colourful drawing?
- Process

(ili) What is the outcome of this activity?

- -Output

Naxl, Ecucation
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a

ﬁ;&, 5 In the Lab

1. Play the Click and draw game in GCompris.
You can find this game in GCompris — Discover the computer —» Mouse
manipulation activities — Click and draw.

[ R—TR— v
Note: Draw the picture by clicking on each blue point in the sequence.

=° Project
o B

Using a calculator, perform an addition problem. Enter the first number (for

example, 5), the second number (for example, 9) and press the + symbol.
What answer do you get?

Use the link given below to use the calculator:

hd
https:/bit.ly/3FtWw26 ?%
(Ok3=H

Self-Assessment

| can On myown (v))  With help (v)
identify the input and output devices.

differentiate between input and output devices based on
their functions.

identify Input, Process, and Output devices.

differentiate between the sections of input, process, and
output respectively.

L 10 Next, Education
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Chip, do you know what all these Look at these arrows and
words and symbols on the keyboard words. They seem like a secret.
mean? | only know the alphabet and spy language to mel

number keys!

Oh no, Jal. They are special keys
that help you give instructions
to the computer in an easier and

Quick review of alphabet keys, «  Shift, Ctrl, Delete and arrow keys
number keys, Enter, Caps Lock, +  Select, cut, copy, paste and delete
Backspace and Space bar keys text

|nfarmatior Ten-uwugy! 1

A computer keyboard is one of the main input devices used with a computer.
With the help of a computer keyboard, we input letters, numbers and other
symbols that can serve as commands or be used to type texl.

'} g computer keyboard has keys marked with the alphabet, numbers and
9 other symbols.

Alphabet keys

The keys on which we see the letters A to Z are called alphabet keys.
are used Lo write words.

= GCI=I=I=])
= 0 |

Number keys

The keys on which we see the numbers from 0 to 9 are called number keys.
These are used to type numbers.

We find another set of keys marked with numbers on the right side of the
keyboard. This is called the number pad.

Apart from the alphabet keys and number keys, the keyboard also has some
special keys. Each special key has its own function.

1
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Enter

The Enter key is used to go to the next line while typing paragraphs
poems. A kevboard usually has two Enter keys.

RREE

]
[E[F [ ]

To go to the next line press Enter key.| = | Press Enter key here

To go to the next line press Enter key.
P~

| he cursar or insertion palr s 10 the rext line

P‘. A cursor or insertion point is the place on the monitor where we can see
®Y what is typed on the keyboard.

Caps Lock

The Caps Lock key, when pressed, causes all the letters to be typed in upper-
case. You need Lo press it again to continue typing in lower-case letters.

)

@A I G CGEETHE
It Jelr Is I* - 2 - It E It

| nfrmati

ase letters.

A

When the Caps Lock key is pressed, a light glows and we can type upper-case
letters.

CAPS LOCK KEY 1S ON N —

When we press the Caps Lock key again, the light is switched off and we can
type lower-case letters.

waps lock ke | Caps lock key is off

Space bar

The Space bar is the longest key on the keyboard. It is used to insert spaces
between words

Computer Science
|

v

pace bar to have space be words

Backspace

The Backspace key = st is like an eraser. It is used 1o erase the

mistakes made while typing. [t erases anything that is on the left side of the
cursor.
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computer sciencs=—=*|

computer sciend
Delete

The Delete key is also used Lo erase texL. It erases anything that is on the right

side of the cursor.

3 CI=l=]

[ EREEEERLBTELT

Shift

A keyboard usually has keys marked with two symbols one below
other, as shown in the figure.

When we press 1 , we can see the number 1 displayed on the monitor.

To type an exclamation mark (!}, we need Lo press ‘| along with the
special key, Shift. s

A keyboard has two Shift keys.

Pressing the Shifl key and an alphabel key together will type the upper-case
letter.

|nfrmati

Ctrl

A special key marked ‘Ctrl’ is called the control key. It is always used in
combination with other keys to do certain tasks.

s "y
For example, pressing = and keys Logether saves a file in

Notepad or Tux Paint.

Arrow keys

G
ElEE]

Arrow keys are used to move the cursor through the text typed.

Press to move the cursor to the left.

Press to move the cursor to the line above.

Press to move the cursor to the line below.

Press »  to move the cursor to the right.
Select, cut, copy, paste and delete text
We olten need to copy or move a piece of text from one location to another.
To copy or move a piece ol text, we have to select it first.
To select the text using keyboard keys, follow the steps given below.
Shartcut
Shift and right arrow key

To select
The character on the right side of the

cursor
B
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Ctrl

A special key marked ‘Curl" is called the control key. It is always used in
combination with other keys to do certain tasks.

' s
For example, pressing = and
Notepad or Tux Paint.

keys together saves a lile in

Arrow keys

Arraw leys dl'?'\bed“w muvle the cursor through the text typed.
Press move the cursor Lo the left

Press to move the cursor to the line above.

Press 4 move the cursor Lo the line below.

Press » o move the cursor to the right.

Select, cut, copy, paste and delete text

We often need to copy or move a piece of text from one location to another.
To copy or move a piece ol text, we have to select it first.

To select the text using keyboard keys, lollow the steps given below.

To select
The character on the right side of the
cursor

16 | Mest, Education

To select
The character on the left side of the

cursor

The text in the line above

The text in the line below

The text from the current location
of the cursor to the beginning of the
line

The text from the current location of
the cursor to the end of the line

The text from the current location to
the page above

The text from the current location to
the page below

The whole text

Shartcut
Shift and right arrow key

e 4+

shortcut
Shift and left arrow key

= 4 =
Shift and up arrow key
s + 4
Shift and down arrow key
- + 5
Shift and Home key
- +
Shift and End key
Shift and Page Up key

Fapn
ity

Shift and Page Down key
+ B
Ctrl and A key

L

Commonly, the following three things are done when a piece of text is

selected.

« Copy and paste the selected text - It duplicates the selected text in more

than one place.

» Cut and paste the selected text — [t moves the text from the original

location to the new location.

« Delete the selected text.

C} Scanned with OKEN Scanner
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To select Shortcut

. . Shift and left arrow key
The character on the left side of the :

cursor + -
Shift and up arrow key

The text in the line above : A

Shift and down arrow key

The text in the line below B 3

The text from the current location Shift and Home key
of the cursor to the beginning of the
line

s : Shift and End key
The text from the current location of '
the cursor to the end of the line = + s

i : ) Shift and Page Up key
The text from the current location to BE VP X8}
the page above -

. Shift and Page Down key
The text from the current location to 2

the page below i + [

Ctrl and A key

The whole text + A

Commonly, the following three things are done when a piece of text is
selected.

« Copy and pasle the selected text - It duplicates the selected text in more
than one place.

Cut and paste the selected text — It moves the text from the original
location to the new location.

Delete the selected text.

|nfarmation Tm.-umug-,! 17

Copy and paste the selected text
« To copy the text selected, press = and © together.

« Now, use the arrow keys or the mouse to place the cursor at the location
where the text is Lo be moved.

v
« Press and together. A copy of the text will be pasted here.

When we copy and paste text, it is present both in the original and the new
location.

Cut and paste the selected text
To move the text selecled, press = and * logether.

Now, use the arrow keys or the mouse to place the cursor at the location
where the text is to be copied

v
Press = and together. The text is now moved

Cut and paste is used to delete the text from its original location and move it
to a new location.

Delete the selected text
We can delete the selecled text by pressing o or =—:=

g Type the sentence The quick brown fox jumps over the lazy dog.’ to practise
the position of all the alphabet keys on the keyboard

hn? Key points

«  Akeyboard has keys marked with the alphabet, numbers and symbals.
Shift and Ctrl keys are used in combination with other keys.
The Delete key is used to delete characters on the right of the cursor.

The Backspace key is used to delete characters on the left of the cursor.

@y 18 ‘N;f:l Education
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Copy and paste the selected text
©
To copy the text selected, press and together.
Now, use the arrow keys or the mouse to place the cursor at the location
where the text is to be moved.
v .
« Press = and together. A copy of the text will be pasted here.

When we copy and paste text, it is present both in the original and the new
location.

Cut and paste the selected text
To move the text selecled, press o and ¥ logether.

Now, use the arrow keys or the mouse to place the cursor at the location
where the text is to be copied.

v

Press = and together. The text is now moved.
Cut and paste is used 1o delete the text from its original location and move it
to a new localion.

Delete the selected text
We can delete the selected text by pressing

g8 Type the sentence The quick brown fox jumps over the lazy dog,’ to practise
™Y the position of all the alphabet keys on the keyboard.

f Key points

«  Akeyboard has keys marked with the alphabet, numbers and symbals.
Shift and Ctrl keys are used in combination with other keys.
The Delete key is used to delete characters on the right of the cursor.

The Backspace key is used to delete characters on the left of the cursor.

18 | ten cducation

Arrow keys (up, down, right, left) are used to move through the text typed.
Select a piece of text to copy or move it.
The text that is copied or cut can be pasted at a new location.

The copy operation keeps the text in its original location besides duplicating it
at a new location when pasted.

The cut operation deletes the text from its original location and moves it to a
new location when pasted.

F  Worksheet

1. Tick (v') the correct answer.

(a) Which key will you press to delete the character to the left of the
cursor?

iy B ii) & i) - emawe iv) =n

(b) Which key will you press to delete the character to the right of the
cursor?

i} it) [ ili) - V) A e

(c) Which key will you press to move the cursor to the line below the
current location?

i) - i) * i)+ iv) ¢

(d) Which key is pressed to start typing from a new line?
ii) | i) .. iv)
(e) To save a drawing in Tux Paint, press key and e

L7 .
i) iv)
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(f) Pressing Ctrl and C keys together.
i) moves the text ii) copies the text
iii) deletes the text iv) jumps the text

(g) Deepak wants to move a piece of text. Which of the following
instructions should he follow?

i) Select the piece of text and press Ctrl+M and Ctrl+V.
ii) Select the piece of text and press Ctrl+C and Ctrl+V.
iii) Select the piece of text and press Cirl+K and Ctrl+V.
iv) Select the piece of text and press Ctrl+X and Ctrl+V.

(h) Chetan wants to type 'Mahatma Gandhi’ and the keyboard's Caps Lock
is off. What should he do to type upper-case letters?

i) He should use the Shift key.

ii) He should use the Ctrl key.

iii) He should use the Enter key.

iv) He should use the right arrow key.

Gurpreet wants to type '%’. To his surprise, when he presses the key
marked %', he types ‘5. What should he do?

i) He should press the Enter and % keys simultaneously.
ii) He should press the Shift and % keys simultaneously.
i) He should press the Ctrl and % keys simultaneously.
iv) He should press the Delete and % keys simultaneously.
(j) Bindu wants to move through the text she has typed. She should use
i) arrow keys ii) alphabet keys

fii) number keys iv) symbol keys

iy, 20 | Mext eaucanon
el

Read the following statements and state whether they are true or false.

(a) Pressing Ctrl and A keys simultaneously will select the whole line in the
text.

(b) The function of Copy and Cut is the same. They duplicate the text.

(c) To copy or move a piece of text, we need to select it first.

(d) To shift to the next line while typing, press the Enter key.

(e) The Delete and Backspace keys delete characters.

Fill in the blanks,

(a) keys are used to move the cursor through the text typed.
(b) A special key marked ctrl is called the key.

(c) key erases anything on the right side of the cursor.

(d} A is the place where the text is inserted.

(e) The keys that have their own function are called keys.

Find all six names of the special keys in the following grid and circle them.

P A C E B A (8]

Q
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PE;.: In the Lab

1. Open Notepad and type the following poem.
1,2,3,4,5

Once | caught a fish alive;

6,7,8,9 10!

Then | let it go again.

Why did you let it go?

Because it bit my finger so.

Which finger did it bite?

This little finger on my right.

@3 Help students understand the usage of Shift and Ctrl keys. (Shift
=5  key Is used while typing , 7 and so on, and to save the file, Ctrl
and S keys should be pressed together.)

2. Type the following in Notepad, except the text that is highlighted in
green. Then copy and paste the text.

This is the way we wash our face,

ash our face
This is the way we wash our face, early in the morning.
Wash wash wash. Wash wash

This is the way we comb our hair,

This is the way we comb our hair, early in the morning.
Comb comb comb. Comt comt

3. Play the falling words game. Type the falling letters befare they reach the
ground.

To play the game, go to

GCompris — Discover the Computer —» Keyboard Manipulation — Simple
Letter

Help the students open the game. This game will help them learn
A@ the position of alphabet keys on the keyboard.

"".', Project
g ol

Imagine you are designing a new keyboard where you can put three special
keys of your choice. What will these keys be? Draw them in your notebook
and colour them using your favourite colours. Write a line each explaining
the functions of the three keys.

Self-Assessment

I can Onmyown (v) With help (+)
Identify different keys of the keyboard
use special keys of the keyboard effectively.

differentiate betwaen the three types of keys of the
keyboard.

Heat, Education
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Vroom vroom...
WITTTroooocoommm...

Jai, what are you doing
with my mouse? It's not
acarl

Don't worry, Aditi. He is using it to
move the cursor on the screen. We
use the mouse to select and point
to screen objects, like you use a
remote control with your TV,

Review of left and right mouse +  Correct way to hold a mouse
buttons, scroll wheel « Dragging and dropping an item
Left-click, double-click, right-click and

scrolling

A computer mouse is used to

point at and select items on

the monitor. The arrow on the

screen that moves when we move  Mouse pointer =
the mouse is called the mouse

pointer or cursor.

A mouse is generally placed on a flat mouse pad. Tt
helps the mouse move easily and correctly.

A mouse generally has two butlons, a left button and
a right button. In between these two buttons is a small
wheel called the scroll wheel.

The pressing of a button on the Scroll wheel

mouse is called a click. Right button

To select an item or left-click, follow Lett buttan
these steps. el
1. Place the pointer on the item

2. Press Lhe lefl bulton once

This action is called left-click or click.

To open or start an item, follow these steps.

1. Place the pointer on the item

2 >ss the left button twice, quickly

This action is called a double-click.

right button once
This is called a right-click. This
displays a small window with a list of
oplions to control the item. Click Open
to start the item.

CE Scanned with OKEN Scanner
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Scrolling

The scroll button is used to move up or down a page. The
action of moving up or down a page is called scrolling.
Correct way to hold a mouse

r right h on the mouse and put vour index

finger on the left button and the middle finger on the right
s of the mouse to

mouse with your lefl hand do vice-versa
Using a mouse for a long time and not holding it properly
may cause strain and damage to the muscles of the hand
Drag and drop
The drag and drop operation lets us move items from one location to
another.
Let's look at the steps to move an image from one place to another using drag
and drop operation.
1. Place the mouse poinler ¢
2. Press the left mouse button a ) while y 1 the image
to the desired location
Once vou place the image where you want it, lift your {inger from the left
button
The image will be moved to the desired location. Similarly, you can move
other items using the drag and drop operation

Evolution of the computer mouse

Waooden mouse Ball mouse Optical mouse

informarion Technology| 27 o
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i-_‘} Dermnonstrate the actions of the mouse in the computer lab using
k‘ﬁl Notepad.
‘2.5 Key points
* The various actions of the mouse are |eft-click, right-click, scroll and
double-click.

+ Items can be moved from one location to ancther using the drag and
drop action of the mouse.

1
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;.".‘) Demonstrate the actions of the mouse in the computer lab using
lél Notepad.
hﬁ Key points

+ The various actions of the mouse are left-click, right-click, scroll and
double-click.

= Items can be moved frem one location to another using the drag and
drop action of the mouse.

28 ‘ Mt Education

P

F,P Worksheet

1. Ruby is using a mouse to do the following tasks. Tick (v') the correct mouse
action.

(a) She opens a folder named Games on her computer.
I % U,

Left-click Double-click Right-click Drag and drop

(b) She selects a game.
o
Gl o
v

Left-click Double-click Right-click Drag and drop Scroll

(c) She plays a game where she has to put scattered fruits into the correct
baskets.

13 | %,
- o %

‘e

Left-click Double-click Right-click Drag and drop

4
>

(d) She quits the game by choosing, ‘Yes, | want to quit.’

" <, -
s o *
U 4
»
/

Left-click Double-click Right-click Drag and drop

Information Technola
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é

(e) She goes down a list to find a song.

ah " €, _
o o 5 7
A
a e /-f‘
]
J

Left-click Double-click Right-click Drag aﬁd drop Scroll
(f) She goes to the next page of a book without using keyboard keys.

o, _
N

% )

7

Right-click Drag and drop

scnocg

.
o o

c.\! A'

Left-click Double-click

sonoL,

{g) She moves all her drawings to the ‘Drawings’ folder.

L ] € =
o e | !"‘k 4%
> |

e e ]

Left-click Double-click Right-click Drag and drop
Let’s colour and learn
(a) Dharmesh is playing a game where objects appear. He has to use only
a particular mouse action to score points. He will lose points for the
wrong actions.
The object and the related mouse action are as follows.
Object Mouse action
Car Left-click
Candy Right-click
Cap Scroll

Animal Double-click

@ L 30 | NeatEducation

Given below are scenes from the game. Colour the part of the mouse that
has to be clicked.

Scene from the game Part of the mouse
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Given below are scenes from the game. Colour the part of the mouse that
has to be clicked.

Scene from the game Part of the mouse

Information Technology| 31 J @

1. Fill the Sudoku with the following words
Scroll Wheel Drag - drop Right - click Left - click
Rules to fill the sudaku
(a) All the rows and columns should have all four words.

(b) All the sections (2x2) should have the four words.

Drag - drop Right - click

Left - click

Left - click Right - click

Right - click

2. Sunita has created a folder in the wrong place on a computer. Can the folder
be moved to the right location? If yes, select the correct optionl(s) for the
action.

Cut — Go to correct location —= Paste

Select the folder == Cut == Go to correct location =——
Paste

Copy — Go to correct location — Paste

Select the folder ——= Copy — Go to correct location ——
Paste = Delete it from the wrong location

Cannot move to the right location.
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Pﬁ4m & Inthelab

1. Goto: 2. Open:
GCompris — Discover the GCompris —» Puzzles —»
Computer —s Mouse Manipulation Simplified Tower of Hanoi
Activities — Control the Hose-pipe  yote. Drag and Drop one piece at
Note: Move the mouse over the red part of a time, from one peg to another, to
the hose-pipe. This will move it and bring it reproduce the tower on the right in
part by part up to the flowers. Be careful; if ~ the empty space on the left.
you move off the hose, the red part will go
back down.

(PaHAE
3. Let's play the game of Flappy bird. Use your mouse click to keep the bird

flying.
Rules:

1. Try to cross the abstacles to score a point.
2. If the bird touches the obstacle the score gets to 0.
3. If the bird touches the ground, you lose the game.
Use the link given below to play: https://bit.ly/3smWjbB
ElsE
T

i

&, Project

#‘A ,

Create a mouse using the waste materials and mark the two buttons and

scroll wheel on it.

Self-Assessment

| can Onmyown {¥) Withhelp (+)

hold the mouse in the correct way.

identify the different mouse actions.

differentiate between mouse actions based on their
functionalities.
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Chip, looks like our computar Hope we haven't damaged
is asleep. The mouse and the anything by mistake!
keyboard are not working.

Don't worry, you just need to switch
on the computer. Here you go.

| want to edit the
painting we made last
week. How do | do that?

Let's wait till your desktop
screen appears and then open o
the drawing software. , ’

How to start a computer, wallpaper, + Taskbar - Date and time,

icons minimising applications

Commaon icons — This PC, Recycle Bin - Opening and closing an application
Shutting down a computer

|nformation Tech

How to start a computer

To start a computer, we need to press the power button on
the CPU cabinet.

A computer takes only a few seconds to start.

The display on the opening screen of the computer is called the desktop.

Desktop - Windows
Wallpaper

The picture displayed in the background of the desktop is called the
wallpaper.

Icons

The desktop displays several small pictures called icons. These represent files
that contain songs, videos and applications such as Tux Paint and Notepad
Every icon has a name.

(¥ Scanned with OKEN Scanner



& IT Essentials - Level 2

Common icons - This PC and Recycle Bi

This PC and Recycle Bin are common icons found on almost all desktops.
; |

This PC ;é—_]

This icon indicates a folder containing the details of all the files stored in the
compuler system.

;:') Create the icons, This PC and Recycle Bin if the computers in the
=% school lab do not display these

@i, Flles are created using applications such as Tux Palnt, Notepad etc. For
example, when you save a drawing in Tux Paint, it is saved as a file.

In real life, we generally keep things in an organised way. We keep our pens,
pencils, erasers, sharpeners etc. in a pencil box, and books on a bookshell. In
the same way, the files in a compuler are stored in separate {olders and this
helps us locate them easily.
A pencil box stores A bookshelf stores A folder stores files in a
pens, pencils, erasers, computer
sharpeners etc.

Each folder is given a suitable name that indicates the type of files stored in it
For example, we may store all drawings in a folder named "My Drawings’.

i B
Recycle Bin 3

o~

The Recycle Bin is similar to the garbage bin ‘“‘\ we use at home. When
liles are deleted [rom the computer, they are automatically moved to the
Recycle Bin and are stored there. They can later be emptied from time to
time.

Information Technology| 37

Taskbar

The bottom-most part of the desktop is called the taskbar.
| - B
] | |

émrb Active or Taskbar Date and time
button frequently used applications

Icons of frequently used applications and applications that are already
running on the computer are displayed on the taskbar. For example, in the

image shown above, we can see icons. The date and tlime

are displayed on the right-hand side of the taskbar.
Opening and closing an application

To start an application, such as Tux Paint or

Notepad, double-click the icon. Alternatively, you

may right-click the icon. A menu with several

oplions pops up. From these options, click Open.

For example, double-click the Tux Paint icon Lo start the application,

The Tux Paint window will open.

Open e ocation

LE - ot

@ share with Skyse
Troublcaoct sompatibilty

Pin fu Start

8

Fir o taskbar
Restare previous versians
send e

cu

copy

Create shorteut

Deleze

Rerame

Braperies
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Taskbar

The bottom-most part of the desktop is called the taskbar
| = [EE—
| l

l 1 ‘
Start Active or Taskbar Date and time
button frequently used applications

lcons of frequently used applications and applications that are already
running on the computer are displayed on the taskbar. For example, in the
image shown above, we can see icons. The date and time

are displayed on the right-hand side of the taskbar.
Opening and closing an application

To start an application, such as Tux Paint or

Notepad, double-click the icon. Alternatively, you

may right-click the icon. A menu with several

oplions pops up. From these options, click Open.

For example, double-click the Tux Paint icon to start the application,

The Tux Paint window will open.

Restore previous versions
Send e
cu

copy

Delee

Properies

Right-click the icon

38 ‘ Mext, Education

Observe that the taskbar now shows the Tux Paint icon, indicating it as an
active application.
To close this application, we need to click the Close button % found in
the top-right corner of the application window.

A

[Close bution |

EérR@e | o0 ' eree @

Pick r talor and sty shape: to dinw il

1
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Observe that the taskbar now shows the Tux Paint icon, indicaling il as an
active application.

To close this application, we need to click the Close button % found in
the top-right corner of the application window.
" <
o0l [l b —THENES
o k] - .
Sin) e ™~
e

Pick s color and a bt shape o disw with.

Information Techn

Shutting down a computer

On compleling our work, we should shut down the computer properly. To
shut it down, follow these steps.

For Windows system

Shut down

Restart

o | O oo

O Ask me anything
To close or exit an active application: Alt + F4

To open the Start menu: Ctrl + Esc or press E

;’F Key points

= To start a computer system, press the power button on the CPU
cabinet.

The first display seen on the menitor when a computer starts is called
the desktop.

Small pictures called icons are seen on the desktop that represents
songs, videos and applications.

The taskbar is seen at the bottom of the desktop.

We should always shut down the system properly,
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ﬁ;‘ =5 In the Labh

1. Switch on the computer system in the lab. Observe the monitor coming
alive with a colourful display.

2. Observe your friends’ desktops. Is the display the same on everyone’s
desktop?

3. Find and open the Tux Paint application. Observe and draw the icon for
this application and the other items you find on this window.

4. Shut down the system properly.

EJ Project

Vipul wants to shut down his computer. Given below are the steps in the
circles. Help him number the bubbles in the correct order to shut down the

computer properly.

Click Shut down Click Power Click Start

Self-Assessment
| can Onmyown (v) With help (v)
access Tux Paint.

identify the different components of the Tux Paint window
such as Toolbar, Drawing Canvas, etc.

use the tools efficiently such as Paint tool, Eraser tool, etc.

=

i

&5
E5E

%

Information Techno]ogyl 45
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I saw a beautiful hut in a village
yesterday.

No, | didn't have
a camera.

Jai, let’s try to draw that scene
on the computer. With MS Paint,
you can mix colours and use
different brushes to recreate
the scene

=
A‘
Opening MS Paint + Using shapes and colours
Exploring the Paint window + Saving, opening and printing a
Using pencil, eraser, fill and text tools picture

Neat, Education

Paint is a computer program that helps us create drawings and colour them
It has many tools that are necessary to make beautiful drawings.

Opening MS Paint

To open MS Paint, follow these steps

1. Click on the start buttor n Gl e

2. Type “paint’ in the ox on the taskbar. A list of available
applications is displayed

3. Click on Paint from this list. The Paint
window «
Exploring the Paint window

Let us explore the components of the Paint window.

Click the arrow to choose
the type of brush

5

& @ A4 Clickon Calor1 and select the color far the brush,
-

« Drag the mouse 1o draw

Title bar

The topmost part of the window is called the title bar. It displays the name of
the drawing and the name of the application i.e., Paint.

FIRNS e

name of the drawing and the application name.
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Paint is a computer program that helps us create drawings and colour them
It has many tools that are necessary to make beautiful drawings.

Opening MS Paint

To open MS Painl, follow these
1. Click on the start buttor ﬂ diClinie

T'ype ‘paint’ in the search box on the taskbar. A list of ave

pplications is displayed

3. Click on Paint from this list. The Paint
window opens.

Exploring the Paint window
Let us explore the components of the Paint window.

Click the arrow to choose Click the arrow ta choose
the type of brush the size of brush

o (A, e

# . J A Click on Color1 and select the color for the brush.

——= Drag the mouse to draw

Title bar

The topmost part of the window is called the title bar. It displays the name of
the drawing and the name of the application i.e., Paint.

name of the drawing and the application name.

Information Techn \\.g,} 47 4

Ribbon

Below the title bar is the Ribbon. [t contains three tabs: File, Home and View.
These tabs allow us to perform important tasks in Paint.

“ Home View |

When we open the Paint window, the Home tab is already selected.

A group contains related commands arranged together. We find Clipboard,
Image, Tools, Shapes and Colors groups in the Home tab.

Drawing area

The portion of the window in white where we can draw and colour is called
the drawing area or canvas.

Using tools
il with colaur
Click an on the canvas to fill it with
the fareground colour. o right-click to
fill th the backgraund colour.

Text

|
Pencil I
ree-form line with :

2 linz width — | /A o Inserts text in the picture.

g 20

anification
Erases a part of the picture » for a part of the plcture
and replace it with the
background calour
Colour picker
Picks a colour from the picture
and uses it for drawing

The Tools group in the home tab consists of various tools that help us to
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Ribbon

Below the title bar is the Ribbon. It contains three tabs: File, Home and View.
These tabs allow us to perform important tasks in Paint.

Home View |

When we open the Paint window, the Home tab is already selected.

A group contains related commands arranged together. We find Clipboard,
Image, Tools, Shapes and Colors groups in the Home tab.

Drawing area

The portion of the window in white where we can draw and colour is called
the drawing area or canvas.

Using tools
Fillwith colour
Click an area on the canvas to fill it with
the ground colour, or right-click to
karound colour.

Text
Draw a free-form line with

the selected linz width d 4| Inserts text in the picture.

Changes the magnification
Erases a pay

for a part.of the picture
and replace it with the

background calaur.
Colour picker

Picks a colour from the picture
and uses it for drawing

The Tools group in the home tab consists of various tools that help us to
draw. The tools available in the Tools group are:

& |, 48 ‘ Neat, €ducation

« Pencil « Fill with color « Text » Eraser « Color Picker
« Magnifier

Pencil -~

The Pencil tool helps with free-hand drawing.

To create a drawing using the Pencil tool, follow these steps

1. Click on the pencil tool.

2. Select the thickness of the tool

3. Click on Color 1 to set the colour for the pencil.

1. Select the desired colour from Colors

he mouse on the drawing area to draw a picture

Fill with color ¢

The "Fill with color” tool helps to fill colour in a drawing.

To lill with colour, follow these steps.
1. Select “Fill with color
Click on Color 1 to set the colour to fil

3. Select a colour from Colors.

|nformation Technol
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Click on the part of the picture that you wish to fill with colour

EET———

2 3

L

Text A

To insert text into the picture, select the Text tool.
To insert text in the drawing, [ollow these

Click on the Text tool

Click on Color 1 to set the colour of th
. Select the colour of the text from Color

drawing area

Eraser

Like an actual eraser, this tool helps us erase any part of the drawing.
To erase, follow these step.

1. Select the Eraser tool. The mouse pointer change

2. Drag the mouse on the picture to eras

Notice that the erased part of the picture is replaced with the back
colour (Color 2).

Color Picker

The Color Picker tool is used to pick a colour from one part of a picture and
use it to fill another part.

1 colour, follow these steps.

Fill with color

Select Color Picker

Click on the part of the picture to pick the colour. Observe Color 1

chang

e colour selected from the picture

L. Click on the new portion of the picture to fill it with this colour

Information Techno
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Eraser

Like an actual eraser, this tool helps us erase any part of the drawing.

[o erase, follow these steps

1. Select the Eraser lool. The mouse pointer changes to the Eraser too
he mouse on the picture to ¢

Notice that the erased part of the picture is replaced with the background
colour (Color 2).

mEmEs wEmm gy
= ol

Color Picker

The Color Picker tool is used 1o pick a colour from one part of a picture and
use it to fill another part.

ick a colour, follow these ste
Select “Fill with color
Select Color Picker.

Click on the part of the picture to pick the colour. Observe Color 1
changing t selected from the picture.

Click on the new portion of the picture to fill it with this colour

Informaticn Tachnology| 51 £

Observe colour 1 changing to the calour
picked from the picture,

Magnifier

The Magnifier tool is used to zoom into a specific part of the picture on the
canvas area. Left-click the mouse button to zoom into the picture and right-
click to zoom out

My house

& L 52 ‘Nvﬂiﬂura:\vn
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[ ussss ssss
=/ "gary=sgeam o

Observe colour 1 changing ta the calour
picked from the picture

Magnifier ||

The Magnifier tool is used to zoom into a specific part of the picture on the
canvas area. Left-click the mouse button to zoom into the picture and right-
click to zoom out

My house

b 52 | Mt gducation

\
Brushes
s

The Brushes tool is used to draw brush strokes on the canvas area
To draw using a brush, follow these steps

1. Click on the Brushes option.

2. Select the type of brush you v to use from Lhe list of brushe:
3. Select the thickness for the brush

1. Click on Color 1

5. Pick a colour from the Color palette for Colar 1

he mouse on the drawi ea lo create a brush stroke.

Wemms wammgy

Shapes
The Shapes tool is used to draw certain shapes easily.

To draw a shape, follow these steps,

1. Select the shape from the Shapes group

Select the thickness for the outline of the shape.
Click on Color 1.
Select the colour for the shape outline from the Colors palette.

Click and d 1e mouse on the canvas area Lo draw the shap

Informaticn
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Brushes &

Brushes

The Brushes tool is used to draw brush strokes on the canvas area.
To draw using a brush, follow these steps
1. Click on the Brushes option
2. Select the type of brush you want to use from the list of

Select the thickness for the brush
L. Click on Color 1.
5. Pick a colour from the Color palette for Color 1

mouse on the drawing area o create

T.:-—, ey

5

Shapes
The Shapes tool is used to draw certain shapes easily.
To draw a shape, [ollow these steps.
1. Select the shape from the Shapes group.
Select the thickness for the outline of the shape
Click on Color 1.
Select the colour for the shape outline from the Colors palette

Click and drag the mouse on the canvas area to draw the ve of the
desired size

Colors

The Colors group is used to select the colour to be used in the canvas area.

There are two colour options. Color 1 shows the selected colour for the
pencil, brush and shape outlines. Color 2 shows the colour that is selected to
be filled inside a space on the canvas.

T ect a colour, follow these steps.
1. Click on Color 1 for outlines or Color 2 for filling
2. Click on a colour from the options displayed

If the desired colour is available, click on ‘Edit colors’ and choose the

colour you wish to use and click on OK

EEEE V] . , illul",lﬁlgl

& L 54 | NeatEducation
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ukd e o Cobrs

Saving, opening and printing a picture

Saving a file

It is very important to save your drawing after you have finished it. Once it is
saved, we can open and make any changes at any time.

To save a file, follow these steps.

1. Click on the File tab. A menu list will open

Click on Sav

information Technology| 55 o

OR

3. Click on the Save icon on the Quick Access Toolbar

. The Save as dialog box is displayed.

Choose the location of the file to be saved
Type the name for the file in the ‘File name'
Click
(=]
mamms mmmmy

Opening a file
If we want to work on a drawing saved earlier, it first needs to be opened.
To open a file, follow these steps.

n the File tab. A menu list will
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Description Shortcut key

To save the current picture Ctri+S
To open an existing picture Ctrl+0

To create a new picture Ctri+N
To print the current picture Ctri+P

b gi Key points

1%

2,

The title bar of the Paint window contains the Quick Access Toolbar, file name
and control buttons

The menu bar is found just below the title bar with options such as File, Home
and View,

A ribbon with various tools arranged in groups is found below the menu bar.
The groups, Tools, Shapes and Colers have various options to choose from.
To create a new picture, click on File from the menu bar and click on New.

To save the current picture, click on File from the menu bar and click on Save.
To print the current picture, click on File from the menu bar and click on Print.
To save the picture as a new file, click on File from the menu bar and click on
Save as.

To close M5 Paint, click on the close button from the control buttans on the
title bar,

Information Techn

#" Worksheet

Lock at the image and read the given clues. Write the clue number against
the highlighted part.

(a) To open MS Paint, type ‘paint’ in the search box on the taskbar.

(b) This is the top-most bar of the Paint window.

(c} The title bar contains this toolbar in the left corner.

(d) These buttons found on the right side of the title bar help us
manage the Paint window.

o
[ L] N
Hel IR

Choose the correct answer.
(a) The shortcut key to save the current picture is

(i) Ctrl+S (i) Ctrl+O (i) Ctrl+N (iv) Ctrl+P
(b} To close MS Paint, click

(iv) E

o, B Baa Rl SRR

HE RO LR

S S
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(c) Color 1 tool is used to:
(i) Set the colour for the background of the picture
(ii) Set the background colour for the Fill tool
(iii) Set the foreground colour for the Pen tool
(iv) Set the colour for the Eraser tool

(d} Save as option in the File menu is used:
(i) To save the file with the same name
i) Ta save the file with a different name
(iii) To save the file with new changes
(iv) To save the file with old changes
A isusedto
(i) Insert Wordart in the picture
(i) Insert rhymes in the picture
(iii) Insert numbers in the picture
(iv) Insert text in the picture

3. State whether true or false.

(a) Microsoft Paint is a simple painting application that is available with
Micrasoft Windows,

(b} To save the current picture in a different location with a different
name, click on Save from the File menu.

(c) To print the current picture, select Print from the File menu.

Information Techno

(d} Eraser tool helps erase a part of the picture and replaces it with the
foreground colour.

(e) Noori wants to draw a hexagon. She will find this tool in the
Tools group.

4, Tick (v) the correct answers.

H Start button

Title bar contains [*] = Quick Access Toolbar
@ X control buttons
Tooals
is found in this group Stationery
Shapes
fill with colour
is a tool used to erase part of the picture

pick a colour

5. The letters of the words are jumbled. Figure out the word and write it in
the space provided.

1.IBBNOR
2. CENILP
3. REASER

4. ARMAGNIEFI

BRSHESU

62 | Mt Ecucation
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g i
- Inthe Lab
P‘,{.\‘d‘ n the Lal

Create a drawing in Paint by following the instructions shown in the
picture. After completing the drawing, save the picture and print it.
Finally, close the Paint application

Use a triangle from the Shapes group.

Drag the mouse on the drawing area to form a shape.

Click Fill with colour from Tools groups.

Select the calour shape fram the colours group for colour 2.
Click on the closed area of the triangle.

Use Air brush
Use the line tool G B Y from Brushes
from Shapes
group.

| Use rectangle from
*| Shapes group.

Use the
curve tool

17, from Shapes
group

2. Draw any object using the free-hand tool and the shape tool and analyse
which one is better to use.

Neat, Education

Demonstrate the toals discussed in the chapter in the computer lab.

Project
[ 2

Many organisations in India and abroad work to
solve sacial issues such as illiteracy, poverty, child
labour etc.

Make groups of three students. Discuss and
choose a social topic that you would like to
bring to the notice of the school authorities.
Create a poster using MS Paint and highlight

the important points. Save the poster on the
computer in your school lab and take a print-out.
Paste the print-out on the class or school bulletin
board.

Self-Assessment
| can Onmyown (v)  With help ()
use the MS Paint application effectively.
use different tools such as pencil, fill with color etc.

perform operations like save, print, open and close.

nformation Technology| 65 o @
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I saw a beautiful hut in a village
yesterday.

No, | didn't have
a camera.

Jai, let’s try to draw that scene
on the computer. With MS Paint,
you can mix colours and use
different brushes to recreate
the scene

=
A‘
Opening MS Paint + Using shapes and colours
Exploring the Paint window + Saving, opening and printing a
Using pencil, eraser, fill and text tools picture

Neat, Education

Paint is a computer program that helps us create drawings and colour them
It has many tools that are necessary to make beautiful drawings.

Opening MS Paint

To open MS Paint, follow these steps

1. Click on the start buttor n Gl e

2. Type “paint’ in the ox on the taskbar. A list of available
applications is displayed

3. Click on Paint from this list. The Paint
window «
Exploring the Paint window

Let us explore the components of the Paint window.

Click the arrow to choose
the type of brush

5

& @ A4 Clickon Calor1 and select the color far the brush,
-

« Drag the mouse 1o draw

Title bar

The topmost part of the window is called the title bar. It displays the name of
the drawing and the name of the application i.e., Paint.

FIRNS e

name of the drawing and the application name.
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Paint is a computer program that helps us create drawings and colour them.
It has many tools that are necessary to make beautiful drawings.

Opening MS Paint

To open MS Paint follow t
1. Click on the start buttor ﬂ S peime

T'ype ‘paint’ in the search box on the taskbar. A list of 2

wpplications is displayed

3. Click on Paint from this list. The Paint ¥
window opens Desciop spn

Exploring the Paint window

Let us explore the components of the Paint window.

Click the arrow to choose Click the arrow to chaose
the type of brush the size of brush

——= Drag the mouse to draw

Title bar

The topmost part of the window is called the title bar. It displays the name of
the drawing and the name of the application i.e., Paint

name of the drawing and the application name.

Information Teck

Ribbon

Below the title bar is the Ribbon. It contains three tabs: File, Home and View.
These tabs allow us Lo perform important tasks in Painl.

I
“ Home View |

When we open the Paint window, the Home tab is already selected.

Group

A group contains related commands arranged together. We find Clipboard,
Image, Tools, Shapes and Colors groups in the Home tab.

Drawing area

The portion of the window in white where we can draw and colour is called
the drawing area or canvas.

Using tools
Fill with colau
Click €a on the canvas to fill it with
the fareqraund colour, or right-click to
fill it with the background colour.

Pencil
rez-form line with Text
ed linz width. ’ s Inserts text in the picture.

!

Changzs th
Erases a part of the pisture » for 3 part o
and replace it with the
background colour
Colour picker
Picks 2 calour from the picture
and uses it for drawing

The Tools group in the home tab consists of various tools that help us to
draw. The tools available in the Tools group are:

CX Scanned with OKEN Scanner
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Ribbon

Below the title bar is the Ribbon. It contains three tabs: File, Home and View.

These tabs allow us Lo perform important tasks in Painl.

“ Home View

When we open the Paint window, the Home tab is already selected.

Group

A group contains related commands arranged together. We find Clipboard,

Image, Tools, Shapes and Colors groups in the Home tab.

Drawing area

The portion of the window in white where we can draw and colour is called

the drawing area or canvas.

Using tools

The Tools group in the home tab consists of

nvas to fill it with

qround colour. or right-click to
th the backaround colour,

Pencil
Draw a free-form line with
the selected linz width,

M

Changes th
Erasosa part of ¢ for a part o

and replace it with the
background calour.
Colour picker
Picks a calour fram the picturs
and uses it for drawing

draw. The tools available in the Tools group are:

« Pe

axt, Eaucation

L 48 | e

ncil o Fill with color  « Text « Eraser

+ Magnilier

Pencil
The Pen
To cr

1. Click

3. Click

Select t

cil tool helps with free-hand drawing,
e a drawing using the Pencil tool, fol
on the pencil tool

hickness of tool

on Color 1 to set the colour for the pencil

Select the desired colour from Colors

various tools that help us to

« Color Picker

> mouse on the draw rea to draw a picture.

Fill wit

-
I
;

4

h color ¢

The “Fill with color” tool helps to fill colour in a drawing.

To fill with colour, follow these steps.

1. Selec

t “Fill with color

2. Click on Color 1 to set the colour to fil

3. Selec

t a colour from Colors

Information Technolc
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Click on the part of the picture that you wish to fill with colour

EET———

2 3

L

Text A

To insert text into the picture, select the Tex! tool.
To insert text in the drawing, [ollow these

Click on the Text tool

Click on Color 1 to set the colour of th
. Select the colour of the text from Color

drawing area

Eraser

Like an actual eraser, this tool helps us erase any part of the drawing.
To erase, follow these step.

1. Select the Eraser tool. The mouse pointer change

2. Drag the mouse on the picture to eras

Notice that the erased part of the picture is replaced with the back
colour (Color 2).

Color Picker

The Color Picker tool is used to pick a colour from one part of a picture and
use it to fill another part.

1 colour, follow these steps.

Fill with color

Select Color Picker

Click on the part of the picture to pick the colour. Observe Color 1

chang

e colour selected from the picture

L. Click on the new portion of the picture to fill it with this colour

Information Techno
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Eraser

Like an actual eraser, this tool helps us erase any part of the drawing.

To erase, follow these steps

1. Select the Eraser tool. The mouse pointer changes to the Eraser too

2. Drag the mouse on the picture to erase

Notice that the erased part of the picture is replaced with the background

colour (Color 2).

Color Picker
The Color Picker tool is used to pick a colour from one part of a picture and
use it to fill another part.
To pick a colour, follow these steps.
Select “Fill with color
Select Color Picker.
Click on the part of picture to pick the colour. Observe Color 1
ed from the picture

to fill it with this colour

Information Techn

mumns snmng

Observe colour 1 changing ta the calour
picked from the picturs

L8

Magnifier
The Magnifier tool is used to zoom into a specific part of the picture on the
canvas area. Left-click the mouse button to zoom into the picture and right-

click to zoom out

My house

Neat, Education
CillS

BRI
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mEmms mEEEy g

Observe colour 1 changing to the colour
picked from the picture

Magnifier

The Magnifier tool is used to zoom into a specific part of the picture on the
canvas area. Left-click the mouse button to zoom into the picture and right-
click to zoom out.

w O memes semmgy

My house

Neat, Eduration

\
Brushes &
Brushes

The Brushes tool is used to draw brush strokes on the canvas area.
[o draw u a brush, follow these steps
1. Click on the Brushes option
Select the type of brush you want to use from the list of brushes displayed
Select the thickness for the brush
Clicl
Pick a colour from the Color palette for Color 1

e mouse on the dra area to create a brush stroke

e ey

|
5

—td |

AAAANANN A

Shapes
The Shapes tool is used to draw certain shapes easily.
To draw a 2, follow
1. Select the shape from the Shapes group
Select the thickness for the outline of the s
Click on Color 1
Select the colour for the shape outline {rom the Colors palette

he mouse on the canvas area to dra

CX Scanned with OKEN Scanner
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(4 '
Brushes L
ru

The Brushes tool is used to draw brush strokes on the canvas area.
o draw using a brush, follow these steps

Click on the Brushes option.

Select the type of brush you want to use from the list of
Select the thickness for the brush

Click on Color 1.

1 colour from the (

he mouse on the dra

A A TAAAA IAf-

Shapes

The Shapes tool is used to draw certain shapes easily.
To draw follow these steps.

1. Select shape from the Shapes group.

2. Select the thickness for the outline of the shape.

3. Click on Color 1.

t. Select the colour for the shape cutline from the Colors palette

drag the mouse on the cany ea to draw the shape of the

Information Technolagy| 53 ,,(‘:1

Colors

The Colors group is used to select the colour to be used in the canvas area.

There are two colour options. Color 1 shows the selected colour for the
pencil, brush and shape outlines. Color 2 shows the colour that is selected to
be filled inside a space on the canvas.

To select a colour, follow these steps

1. Click on Color 1 for outlines or Color 2 for filling
Click on a colour from the options displayed

3. If the desired colour is not available, click on "Edit colors’ and choose the

colour you wish to use and click on OK

2
T

| EEEEE EEEE |y
Caiot u it C Calar @ Edit

|
1

Iﬁ; El‘ v

Open
| paint 30

& 54 | Nensaunon
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o cont

Saving, opening and printing.a-picture

Saving afile

It is very important to save your drawing after you have finished it. Once it is
saved, we can open and make any changes at any time.

To save a file, follow these steps.

1. Click on the File tab. A menu list will

Click on Save

mation Technolog

OR

3. Click on the Save icon on the Quick Access Toolbar

. The Save as dialog box is displayed.
Choose the location of the file to
vpe the name for the file in the ‘File name
Click Save

=
mmes mmmay

Opening a file

Il we want to work on a drawing saved earlier, it first needs to be opened.

To open a file, follow these steps
1. Click on the File tab. A menu list will

Click on Open
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et Caiers
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ColoriSald

Ak Comton Colors

Saving, opening and printing a picture

Saving a file

It is very important to save your drawing after you have finished it. Once it is
saved, we can open and make any changes at any time.

To save a lile, follow

1. Click on the File

Click on Save

mumngy o

OR
Click on the Save icon on the Quick Access Toolbar

E_

EEmEm IB;Il.‘-.

2. The Save as dialog box is displayed.

1. Choose the location of the file to be saved

e the name for the file in the ‘File name’ text box.

Opening a file

If we want to work on a drawing saved earlier, it first needs to be opened.
To open a file, follow these steps

1. Click on the File tab. A menu list wi

Click on Open
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3. Click on the Save icon on the Quick Access Toolbar.

I'vpe the name for the file in the ‘File name
Click Save

=@ eEEes sy

Opening a file
If we want to work on a drawing saved earlier, it [irst needs Lo be opened.
To open a file, follow these steps

1. Click on the File tab. A menu list will

2. Click on Open

i, 56 el € usaton

=W wemss sams gy

3. The Open dialog box will appear
{. Select the file you want Lo open

5. Click dpen

Dewriens

2 5008
B Desttop |
Documenie hutpant | blecHTML  wodomsldembt  sindowsiCdeskt
& Downloss =
Jn

5~
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Printing a file

Sometimes, we need to take a
print-oul of the drawing on paper
To print a file, follow these step

1. Click on the File tab. A menu

P
. Frevesne rave

2z

1. Click on Print

General

| Select Frinter
= Microsoft XPS Document Writer
7 Send To OneNote 16
78 Snagit 12
< >

Status [Cfrrttofle  Prefemnces
Location
Comment B

Page Range
®A Mumber of copies: [1
23 123

1] 1

Description Shortcut key

To save the current picture Ctrl+S
To open an existing picture Ctrl+0

To create a new picture Ctrl+N
To print the current picture Ctrl+P

Key points
The title bar of the Paint window contains the Quick Access Toolbar, file name
and control buttons,

The menu bar is found just below the title bar with options such as File, Home
and View,

A ribbon with various tools arranged in groups is found below the menu bar,
The groups, Tools, Shapes and Colors have various options to choose from.
To create a new picture, click on File from the menu bar and click on New.

To save the current picture, click on File from the menu bar and click on Save.
To print the current picture, click on File from the menu bar and click on Print.
To save the picture as a new file, click on File from the menu bar and click on
Save as.

To close M5 Paint, click on the close button from the control buttons on the
title bar.

Information Tachnology |
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1. Create a drawing in Paint by following the instructions shown in the
picture, After completing the drawing, save the picture and print it.
Finally, close the Paint application.

. Use a triangle from the Shapes aroup.
. Drag the mause on the drawing area ta farm a shape.

Click Fill with colour fram Taols groups.

Select the colour shape from the colours group for colour 2.

Click on the closed area of the triangle.

Use Air brush

Use the line tool from Brushes.

from Shapes
aroup

T

Use rectangle from
*| Shapes group
1 Use the
curve tool
]__ from Shapes
aroup.

2. Draw any object using the free-hand tool and the shape tool and analyse
which one is better to use,

64 | Mext Education

);-) Demonstrate the tools discussed in the chapter in the computer lab.
o

5. Project
o

Many organisations in India and abroad work to
solve social issues such as illiteracy, poverty, child
labour etc

Make groups of three students. Discuss and

choose a social topic that you would like to

bring to the notice of the school authorities.

Create a poster using MS Paint and highlight

the important points, Save the paster on the CHILD,
computer in your school lab and take a print-out. Lanoes
Paste the print-out on the class or school bulletin

board.

Self-Assessment
I can Onmyown ()  With help (+)

use the MS Paint application effectively.

use different tools such as pencil, fill with color etc.

perform operations like save, print, open and close.
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This is my favourite storybook.
It has colourful pictures and
big letters.

Chip, how is the text
in these book so
beautiful and neat?

Good observation, Jai and Aditi.
These books are created using a
| computer. It allows using pictures
| and text as needed.

| It's amazing what all a

| computer can dol

¥
Introduction to Microsoft Word +  Basic introduction of Word interface
Starting Microsoft Word +  Entering text in a document

Creating a new document + Saving, printing and opening a
document

b 66 | Meat Caucaton

Introduction to Microsoft Word

Computers, in general, are widely used for processing text. Consider the
lollowing image.

1,2,3,4.5!

Qnce | caught a fish alive,

6,7.8,9,10!

Then | let it go again.

Why did you let it go?

Because it bit my finger so.

Which finger did it bite?

This little finger on my right.

Now observe the text of the image given below

sh alive, -
g, 10
o again
tgo
r 5o
1 it bite.

right.

Text processing involves adding a variety of styles and colours and pictures to
the text. A computer application that supports text processing and addition
of pictures is called a word processor. Microsoft Word is one of the most

popular word processing software.

Starting Microsoft Word

To start Microsoft Word, type ‘word' in
the search box of the taskbar.
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A list of applications that match ‘word’ will be displayed. Click Word 2016.
Word 2016 will open.

Creating a new document

Select Blank document option from the given templates.

The tollowing window will be displayed. Observe the components of the
window.

= Restore

Quick Access Toalbar Title bar Filename Minimise
B v ?

Close

4 Y AaBbecdd, AaBbecod Aab ..
.wl\vl;—‘ ety o e ' — '
Ribben
|—= Insertion point
Sroll bar =
Work area/
N - Document area

Status bar

9

Basic introduction of Word interface
Let’s understand these one by one.

Title bar
o The topmost bar is known as the title bar.

o The Quick Access Toolbar is present on the top leftmost corner of the
window. It contains buttons, such as Save, Undo, Redo, etc which are
trequently used.

+ The name of the current document is displayed in the middle of the title
bar. The first new document is always named Document]. You can save it
with any name of your choice later on.

« The title bar contains three buttons on the right corner: Minimise, Restore/
Maximise and Close.

o Next, Education
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Saving, printing and opening a document

Saving a document

To save a file, follow these steps.

1. Click the File tab.

2. Click Save. The following screen will be
displayed.

3. Click This PC.

Various options of folders where we can save our

files, such as Documents, Desktop, etc. will be
displayed. Choose the desired folder.

A Save As dialog box will be displayed. T ——

4. Enter the name of the file; for example, ‘poem’ | 2.2
in the File name text box.

5. Click Save.
The file will be saved.

Observe that the file name is reflected in the title bar.

Insert Design Layout References Mailings Review

A dac Bt © 0 4 aambcend

The Save option is used to save the file, whereas the Save As option lets us
save the file with a new name. This option is
useful when we want to make some changes to a
file, but also want to retain the original file.

After saving the file, we can close it by following
these steps.

1. Click the File tab.

2. Select the Close option.

o l, 70 | Next.Education
B

_Level-2_Chapter_6.ndd 70 \Q)
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Opening a document
To open an existing file, follow these
steps.
Click on the File tab.
2. Select Open

3. Click on the file
Recent folder or

Bre This

Select the file you wanlt to open

The selected file will be opened

5. Click the Open button.

Printing a document

To print a file, follow these steps.
1. Click the File tab.

Select the Print option from tl

Information Techno

3. Click Print

Give a demo of all the topics discussed in the lesson.

=

Task Shortcut key
Open a new document Cul+N

Open an existing document Curl+0

Save the document Cul+S
Print the document Cirl+P

‘F Key points

= Text processing involves adding a variety of styles, colours and pictures to the
text.

A computer application that allows text processing is called a word processor.

A Word window contains a title bar, a status bar and groups of commands
arranged in the Ribbon.

Horizontal and vertical rulers help in the spacing of text in a document.
Vertical scroll bar allows to go up or down a document.

Document area is the place where we type text.

The small vertical bar (|) in the document area is called the insertion point.
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In the Lab

1. Open a new document in MS Word and type the first five sentences of
your favourite storybook. Save the file with the name ‘My story’ and then
close jt.

2.. Open thedfile ‘My'story!. Type fwo more lines and save the file. Print the
© document and then closefit.

I-E-l Project
1. Observe a newspaper carefully and answer the following questions.
(a) Do you find text in different sizes? NewsToday o
(b) Do you find text in different styles? m&f
(c) Do you find text in different colours? ad
(d) Do you find text in boxes?
(
(
(

e) Do you find the text darker at some places?
f) Did the coloured text catch your attention first?

g) Do you think different sizes, styles and colours of
text and boxes make the text attractive?

(h) Which text attracts you first: coloured text, dark
text or bigger text?

;j:j Check the answers given by the students and explain to them the
= importance of text

Self-Assessment

| can On myown (v)  With help (v)

create a document.

open and close the application.

differentiate between the components of the window such
as Ribbon, Rulers, etc based on their functionalities.

save, open and print a document.

& 76

Next. Education
=

_EE_Level-2_Chapter_6indd 76 @

CE Scanned with OKEN Scanner



